## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>7</td>
</tr>
<tr>
<td>Conventions</td>
<td>8</td>
</tr>
<tr>
<td>Related Publications</td>
<td>9</td>
</tr>
<tr>
<td>Customer Support</td>
<td>9</td>
</tr>
<tr>
<td>Information You Should Have</td>
<td>9</td>
</tr>
<tr>
<td>User Feedback</td>
<td>10</td>
</tr>
<tr>
<td>Information Builders Consulting and Training</td>
<td>11</td>
</tr>
</tbody>
</table>

### 1. Using Active Technologies | 13

- Active Technologies Report Overview | 13
- Security Features | 16
- Handling a Large Amount of Data | 17
- Distribution and Viewing Considerations | 17
- Usage Notes for Active Technologies | 19

### 2. Creating an Active Technologies Component | 23

- Creating an Active Technologies Report | 23
  - Active Technologies Report Menu Options | 23
  - Active Technologies Cell Menu Options | 27
  - Configuring Active Technologies Report Options | 28
    - General Tab | 29
    - Menu Options Tab | 30
    - Colors Tab | 31
    - Advanced Tab | 32
  - Freezing Column Headings in Active Reports | 33
- Creating an Active Technologies Chart | 36
  - Active Technologies Options for Charts | 37
  - Usage Notes for Active Technologies Charts | 40
- Creating an Active Technologies Dashboard | 40
  - Active Technologies Dashboard Prompts | 41
  - Target Reports | 41
  - Using Multiple Reports as Targets and Sources | 42

### 3. Active Technologies for Mobile Web Apps | 51

Active Technologies User’s Guide
## Requirements for Mobile Web Apps

### Mobile and Tablet Device Support Information

### Mobile Web Apps Features

### Standard Gesture Support

### Running an Active Technologies Report on a Mobile Device

#### Adjusting the Views

#### Adding an Active Technologies Report or Dashboard to the Home Screen

#### Hiding and Showing the Pagination Bar and the Top and Bottom Toolbars

#### Navigating Between Pages

#### Accessing the Report Column Drop-Down Menu

#### Sorting Data

#### Filtering Data

##### Using the Filter Tab

#### Calculating Data

#### Viewing Data as a Chart

##### Using the Active Technologies Chart Menu

#### Viewing Data in a Rollup Table

##### Using the Rollup Tab

##### Using the Rollup Menu

#### Viewing Data in a Pivot Table

##### Using the Pivot Tab

##### Using the Pivot Menu

#### Using Data Visualization

#### Hiding or Restoring a Column

#### Freezing or Unfreezing a Column

#### Controlling the Number of Records Per Page

#### Restoring a Report to Its Original State

#### Unsupported Menu Options

### Running an Active Technologies Dashboard on a Mobile Device

## 4. Designing Your Applications With WebFOCUS Syntax

### Controlling the Active Technologies Cache

### Suppressing the Display of the Filter Options in a Tooltip
Styling the Filter Selection Dialog Box .................................................. 89
Implementing Cascading Multi Drill ..................................................... 92
Customizing the Page Range on the Pagination Bar ......................... 94
This content describes how to use and work with Active Technologies. It is intended for administrators and developers who are responsible for creating active reports, using active reports to create active dashboards, and creating active reports for Adobe® Flash® Player and for PDF.

The WebFOCUS® tool set generates the rich FOCUS® fourth generation language. While this language is very extensive, the WebFOCUS tool set supports only a subset of the language and only specific syntax constructs. While you can manually modify the content of these WebFOCUS procedures and files, there is no guarantee that you will be able to open the modified procedure in the tool.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Using Active Technologies</td>
<td>Provides an overview of Active Technologies and discusses security and active cache processing. Includes additional information about the features of the product that will help you use it.</td>
</tr>
<tr>
<td>2 Creating an Active Technologies Component</td>
<td>Describes how to create a report, chart, or dashboard that is enabled for Active Technologies using InfoAssist.</td>
</tr>
<tr>
<td>3 Active Technologies for Mobile Web Apps</td>
<td>Describes how Active Technologies features and functions are implemented on mobile devices with multi-touch capability, such as the Apple® iPhone® device and Apple iPad® tablet.</td>
</tr>
<tr>
<td>4 Designing Your Applications With WebFOCUS Syntax</td>
<td>Describes how to implement design features that enhance your applications using WebFOCUS syntax.</td>
</tr>
</tbody>
</table>
## Conventions

The following table describes the conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>THIS TYPEFACE</strong> or <strong>this typeface</strong></td>
<td>Denotes syntax that you must enter exactly as shown.</td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable) in syntax for a value that you or the system must supply.</td>
</tr>
<tr>
<td><strong>underscore</strong></td>
<td>Indicates a default setting.</td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select.</td>
</tr>
<tr>
<td><strong>Key + Key</strong></td>
<td>Indicates keys that you must press simultaneously.</td>
</tr>
<tr>
<td><strong>{ }</strong></td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
<tr>
<td><strong>[ ]</strong></td>
<td>Indicates a group of optional parameters. None are required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td>**</td>
<td>**</td>
</tr>
<tr>
<td><strong>...</strong></td>
<td>Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td><strong>. . .</strong></td>
<td>Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
</tbody>
</table>
Related Publications

Visit our Technical Content Library at http://documentation.informationbuilders.com. You can also contact the Publications Order Department at (800) 969-4636.

Customer Support

Do you have questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at http://forums.informationbuilders.com/eve/forums.

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, http://www.informationbuilders.com. It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of http://www.informationbuilders.com also provides usage techniques, diagnostic tips, and answers to frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

Information You Should Have

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).

- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
The software release.

Your server version and release. You can find this information using the Version option in the Web Console.

The stored procedure (preferably with line numbers) or SQL statements being used in server access.

The Master File and Access File.

The exact nature of the problem:

Are the results or the format incorrect? Are the text or calculations missing or misplaced?

Provide the error message and return code, if applicable.

Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?

What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?

Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. You can contact us through our website, http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.
Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an Education Representative.
Chapter 1

Using Active Technologies

This topic provides an overview of Active Technologies and discusses security and active cache processing. It includes additional information about the features of the product that will help you use it.

This topic also describes the features of an Active Technologies report, which is a report that is enabled to use the full capabilities of Active Technologies. An Active Technologies report is also called an active report.

In this chapter:

- Active Technologies Report Overview
- Security Features
- Handling a Large Amount of Data
- Distribution and Viewing Considerations
- Usage Notes for Active Technologies

Active Technologies Report Overview

An active report is a report that is designed for offline analysis. When using an active report, you can:

- Interact with the data, using analysis options similar to those found in an Excel® workbook, without any connection to a server. Analysis options include filtering, sorting, charting, and much more.

- Work offline without any additional plug-ins or programs. An active report is a self-contained report, meaning that it contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems.

- Save the report on a local machine with active report functionality. Since no connection to a server is required to view the data or use the analysis options, you can save and use the report anywhere.

Note: Performance may vary across browsers due to browser-specific memory limitations. For very large reports, Internet Explorer® may produce an error. For more information, refer to the Microsoft® website.
An active report for Adobe Flash Player includes most of the capabilities available in the HTML version of active reports in a visually enhanced, user-friendly report format. An active report delivered as a self-contained Adobe Flash SWF file that is Adobe Flash Player compatible allows for faster analysis of large data sets and interaction with the active report.

When working with an active report, you can:

- Filter or highlight data.
- Sort data within any column in ascending or descending order.
- Apply calculations to columns and choose the location at which to display results.
- Control the display of data by hiding columns, freezing columns, limiting the number of rows per page, and using graphic visualization to compare column values.
- Create a variety of simple or advanced charts (pie, line, bar, or scatter) and Rollup Tables.
- Apply a global filter to multiple reports within the same HTML page.
- Export report data and chart data.
- Restore original report settings.
- Run active reports on your mobile device with the Opera™ browser (Version 8.60 U2 or higher) installed. See the Opera website for a list of supported devices.
- Run active reports on your iPhone® mobile device. For the best performance results, it is recommended that you set a maximum of 500 records for a mobile report.
  
  Some active report functionality is drag and drop based, and thus not supported with iPhone.
The following image shows an HTML active report. The pop-up menu is open for the Sale Unit(s) column, with the Calculate Avg operator selected.

<table>
<thead>
<tr>
<th>Store Business Region</th>
<th>Store Business Sub Region</th>
<th>Revenue</th>
<th>Sale Unit(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>Africa</td>
<td>$26.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Asia</td>
<td>$396.2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Europe</td>
<td>$31</td>
<td></td>
</tr>
<tr>
<td>North America</td>
<td>Canada</td>
<td>$51.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>East</td>
<td>$39.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mexico</td>
<td>$12.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Midwest</td>
<td>$80.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>$1.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>South</td>
<td>$77.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southeast</td>
<td>$4.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>West</td>
<td>$392.3</td>
<td></td>
</tr>
<tr>
<td>Oceania</td>
<td>Australia-New Zealand</td>
<td>$1.2</td>
<td></td>
</tr>
<tr>
<td>South America</td>
<td>SA-Port</td>
<td>$25.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SA-Span</td>
<td>$1.2</td>
<td></td>
</tr>
</tbody>
</table>

14 of 14 records, Page 1 of 1

1. Using Active Technologies
The following image shows the options that are available at the cell level for a report in active report format. Included are the options that reflect Auto Drill, Multi Drill, and Auto Linking functionality. The applicable documentation for your graphical tool contains more information on that functionality.

**Note:**

- Depending on how your active report has been set up, some options may not be available in your report.
- When using active reports, it is recommended that you set the system font display to **normal** to ensure that the menu icons display correctly.
- Freeze options are only available when a report does not fit in the current window. Therefore if your report fits in the current window, Freeze options appear grayed out in the menu. If you resize the report, or a column or row extends beyond the proportion of the window, then Freeze options become activated and are available for use.

**Security Features**

You can password protect an active report. This feature restricts users from viewing the report by requiring them to enter a password before opening the report. The data is encrypted using the 256-bit Advanced Encryption Standard (AES) specification. The password is used as the key for decrypting and encrypting the data. Therefore, the password is not stored in the report, and you do not need a connection to go back to the server for password verification.
The HTML page that you receive contains both the JavaScript and the data for the report so that you can interact with the data in a disconnected mode. Internet Explorer detects the JavaScript and issues a warning. If you look at the Internet Explorer warning, it mentions explicitly the detection of active content, which is the JavaScript. The same warning appears when pop-ups are blocked in the browser.

Handling a Large Amount of Data

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the Web Query Reporting Server. The server also becomes the resource for performing all calculations, sorting, and filtering when active cache is enabled. Since active cache uses on-demand paging functionality, WebFOCUS Viewer is not supported.

The active report with active cache option in the clustered server environment, using Cluster Manager (CLM), will maintain the connection with the WebFOCUS Web Query Reporting Server on which the temporary cache is created. This enables the retrieval of subsequent pages from the browser, while the report is in the same browser session.

The active cache feature uses a POST instead of a GET in an HTTP request.

If your applications run active cache reports that use WebFOCUS Web Services, see the WebFOCUS Web Services manual for more information.

If your applications run active cache reports that use Web Query Web Services, see the Web Query RESTful Web Services Developer's Guide for more information.

Distribution and Viewing Considerations

Active Technologies stores an active report as an HTML file. The HTML file created by Active Technologies contains both the report data and the JavaScript code that enables you to interact with the data in disconnected mode.

An active report is designed for distribution to users who need to perform offline analysis and interactive functions without connection to a server.

You can save an active report from your web browser to another location. You can also send an active report to another person by email, as an HTML attachment. However, when you distribute an active report, you must keep in mind how it will be viewed.
For example, when you send an active report as an HTML attachment to email, many client email programs on a mobile device can block the JavaScript in the attachment. A third-party tool, such as the Mobile Faves App for a mobile device, may be used to correctly view the attachment.

If you try to view an active report in a web browser, and JavaScript is blocked or disabled on your web browser, you will receive a message reminding you that JavaScript must be enabled on the browser. If you are using a mobile device, the message directs you to use the Mobile Faves App. If the Mobile Faves App is not installed, you can download it from the App Store® for iOS devices or from the Google Play™ store for Android™ devices. In the message, App Store and Google Play store are hyperlinks to the Mobile Faves App.

The message is displayed on the Desktop or on a supported mobile device when JavaScript is disabled in a web browser used to open an online or offline active report. It is also displayed on the Preview pane or window of an application used to preview the content of an offline active report.
The following image shows JavaScript disabled in Google Chrome™.

Usage Notes for Active Technologies

The following apply to browser support.

- Active PDF (APDF) is an Active Technologies output format. It is not supported in Microsoft Edge®, since APDF requires the Adobe Reader plug-in that supports Flash Player.

- ActiveX, a technology from Microsoft, is not supported in Microsoft Edge. Any Active Technologies feature that requires the use of ActiveX controls is therefore not available in Microsoft Edge. These features include the following, which are accessible in other browsers at run time, using the column drop-down menu on an active report:
  - Send as E-mail (supported only in Internet Explorer)
Save Changes (supported only in Internet Explorer)

Export to XML (Excel) when active cache is disabled

If you are using a Firefox® browser and you export an AHTML report to Excel, the file extension that displays is incorrect (for example, .xls.xls). You can override this default value using the settings of the browser. Specifically, if you click the *Always ask me where to save files* radio button, which is located under Options, you will be prompted, upon download, to either open or save the file. You can then provide a name and extension for the file.

The following apply to Active Technologies reports.

- At run time, when fields are added to, or removed from, an active report that includes drilldowns that pass parameter values, the drilldowns are disabled. This is because the parameter values that are passed may no longer apply.

- If multiple report components with different security passwords are included in an AHTML document, the password for the last report component is used.

- Active reports employ left and right cell padding, by default. This enables you to view the active report consistently, without the concatenation of any values or spacing issues related to the cell padding. In cases where these settings are not defined in the StyleSheet, the default settings for the left and right cell padding are used.

- By default, Active Technologies displays the name specified in the Master File to identify a column in an ACROSS group on a tabular active report that has only one display field. With the following SET command, you can display the title specified in the Master File, instead of the name, to identify the column:

  ```
  SET ACRSVRBTITL = ON
  ```

  Active Technologies derives the title from the TITLE attribute in the Master File (for example, TITLE = ‘Product ID’). It derives the name from the FIELDNAME or FIELD attribute (for example, FIELD = PCD).

- The Sort Ascending, Sort Descending, and Restore Original options are accessible on a column drop-down menu on an active report. When active cache is enabled on the active report, the Restore Original option does not return the report output to its original state after sorting the data. Instead, you receive the following message: Warning: Original sort could not be determined.

- When using active content in Cache Mode, filtering may not work properly if the content contains a text field (for example, TX50). As a workaround, consider using an alphanumeric field (for example, A50).
The following apply to Active Technologies charts.

- When working with filters in an AHTML chart, certain filtering options do not display if you have only one column on which to filter and it has a decimal format which includes a decimal point. In this case, the Filter Chart and Exclude from Chart filtering options are not available in the chart tooltip at run time.

- As of Release 8.2 Version 02, the new chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional relevant field containers for these chart types, which can be used to specify fields in a specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field containers that are part of the new chart attribute syntax.

In InfoAssist, specific field containers display for each chart type. For more information on the underlying syntax used to create each chart type, see the *Creating HTML5 Charts With WebFOCUS Language* manual.

- When you run an active chart, the output displays a chart toolbar with a number of options that you can select. These options are represented by icons. The active chart toolbar provides an Aggregation icon that allows you to select the aggregation method (that is, the type of calculation, such as Sum or Avg) that will be used on the selected data in the chart.

If you run an active chart that does not have a measure field to which an aggregation method can be applied, the Aggregation icon:

- Appears on the chart toolbar, but cannot be selected.

- Displays None as the aggregation method. None is dimmed on the label. It indicates that there will be no aggregation performed on, or applied to, the selected data in the chart.

Once you run the active chart with data that applies to an aggregation method, the Aggregation icon is activated. Its label reflects the aggregation method currently in use (for example, Sum).

- The new chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional relevant field containers for these chart types, which can be used to specify fields in a specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field containers that are part of the new chart attribute syntax.

In InfoAssist, specific field containers display for each chart type.
The following applies to Active Technologies tools.

- The comma inclusion edit option is not implemented in Rollup tables and Pivot tables when active cache is enabled.

The following applies when using the Active Technologies Cache option.

- Date-time format fields are not supported.

The following apply when using the Export to Excel functionality.

- When using the Export to Excel option while creating and generating an active report with active cache enabled, the request will be generated in XLSX format rather than EXL2K. This applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

  The export behavior is controlled by the WebFOCUS Reporting Server, and an ActiveX plugin is not required for Internet Explorer. When the export is performed, an Office Open XML document is produced, which you can download and save in the required format (default is .xlsx).

- When using the Export to XML (Excel) option with active cache disabled, the export behavior is controlled by the active JavaScript layer.

  An ActiveX plugin is required for Internet Explorer. This is used to export the output directly into Microsoft Excel, enabling you to save the document in the required format (.xlsx or .xls depending on the Microsoft Excel version installed).

  In Firefox and Chrome, when the export is performed, an MS Office XML document is produced, which you can download and save in the required format (the default is .xls).

  In Microsoft Edge, the Export to XML (Excel) option is not supported. The option is available with active cache disabled, but when the export is performed, the output is displayed as text inside the browser window.

The following apply when using mobile devices.

- The Chrome browser "Force enable zoom" Accessibility setting on Android mobile devices overrides a website request to prevent zooming. If this setting is enabled when executing an AHTML report on an Android mobile device using Chrome, it interferes with active report functionality, such as Freeze Column and manual resizing. The Accessibility setting needs to be disabled for active reports to be fully functional.
This topic describes how to create a report, chart, or dashboard that is enabled for Active Technologies using InfoAssist.

These reports, charts, and dashboards use the full capabilities of Active Technologies. They are also referred to as active reports, charts, and dashboards.

In this chapter:

- Creating an Active Technologies Report
- Creating an Active Technologies Chart
- Creating an Active Technologies Dashboard

Creating an Active Technologies Report

An active report is a self-contained report that is designed for offline analysis.

Procedure: How to Create an Active Technologies Report

With InfoAssist in Report mode, you can perform this procedure in Query Design view or Live Preview.

1. On the status bar, in the Output Types menu, click active report or active PDF.
2. Populate the report with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto the canvas.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

Active Technologies Report Menu Options

Menu options for an active report are described in the following table.

Note: The following options described in the table require the use of ActiveX controls. Since Microsoft Edge does not support ActiveX technology, these options are not available in that browser:

- Send as E-mail
- Save Changes
- Export to XML (Excel) when active cache is disabled

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Ascending</td>
<td>Sorts the column in ascending order.</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Sorts the column in descending order.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters the data. Options are:</td>
</tr>
<tr>
<td></td>
<td>- Equals</td>
</tr>
<tr>
<td></td>
<td>- Not equal</td>
</tr>
<tr>
<td></td>
<td>- Greater than</td>
</tr>
<tr>
<td></td>
<td>- Greater than or equal to</td>
</tr>
<tr>
<td></td>
<td>- Less than</td>
</tr>
<tr>
<td></td>
<td>- Less than or equal to</td>
</tr>
<tr>
<td></td>
<td>- Between</td>
</tr>
<tr>
<td></td>
<td>- Not Between</td>
</tr>
<tr>
<td></td>
<td>- Contains</td>
</tr>
<tr>
<td></td>
<td>- Contains (match case)</td>
</tr>
<tr>
<td></td>
<td>- Omits</td>
</tr>
<tr>
<td></td>
<td>- Omits (match case)</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate</td>
<td>Calculation types that you can apply to the column:</td>
</tr>
<tr>
<td></td>
<td>- Clear</td>
</tr>
<tr>
<td></td>
<td>- Clear All</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct, which counts the number of distinct values within a field</td>
</tr>
<tr>
<td></td>
<td>For numeric fields, you can also apply:</td>
</tr>
<tr>
<td></td>
<td>- Sum</td>
</tr>
<tr>
<td></td>
<td>- Avg</td>
</tr>
<tr>
<td></td>
<td>- Min</td>
</tr>
<tr>
<td></td>
<td>- Max</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct, which counts the number of distinct values within a field</td>
</tr>
<tr>
<td></td>
<td>- % of Total</td>
</tr>
<tr>
<td>Chart</td>
<td>Creates an active chart from the report. Options are Pie, Line, Column, and Scatter.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Lists the fields available to create a table.</td>
</tr>
<tr>
<td>Pivot (Cross Tab)</td>
<td>Lists the fields available to create a Pivot table.</td>
</tr>
<tr>
<td>Visualize</td>
<td>Adds visualization bars to, or removes them from, the selected column. The Visualize option is available for numeric data columns.</td>
</tr>
<tr>
<td>Hide Column</td>
<td>Suppresses the display of the selected column in the report.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Columns</td>
<td>Lists the names of the columns that are hidden in the report, allowing you to individually restore a column. Select the name of a specific column in the hidden columns list to restore that column to the report.</td>
</tr>
<tr>
<td>Freeze Column</td>
<td>Freezes the report at a particular point so that columns to the left of the freeze point remain in view while the user scrolls through the other report columns. <strong>Note:</strong> If the report can be fully viewed in the browser window, freeze is not applied. The Freeze column option is not available for expandable report (Accordion) views.</td>
</tr>
<tr>
<td>Unfreeze All</td>
<td>Unfreezes the columns.</td>
</tr>
<tr>
<td>Grid Tool</td>
<td>Opens the Grid Tool, which you can use to change the column order, select multiple columns to sort ascending or descending, hide and show columns, add a calculation result to a column, and add subtotals to the active report.</td>
</tr>
<tr>
<td>Chart/Rollup Tool</td>
<td>Opens the Chart/Rollup Tool, which you can use to select multiple group fields to generate the chart or rollup table. The Chart/Rollup Tool contains a list of columns available in the active report to add to Group By and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Pivot Tool</td>
<td>Opens the Pivot Tool, which you can use to select multiple group fields to generate the chart or pivot table. The Pivot Tool contains a list of columns available in the active report to add to Group By, Across, and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Show Records</td>
<td>Opens the Show Records menu option to list the number of records available for display per page in the report. Select a number (for example, 10) to display, per page. Default displays the number of records (lines) per page that is specified in the WebFOCUS report procedure.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comments</td>
<td>Options to display comments under cells or hide indicators for comments in the active report output.</td>
</tr>
<tr>
<td>Send as E-mail</td>
<td>Enables you to save the current state of the active report and send the report as email. <strong>Note:</strong> To use this feature, you must have ActiveX enabled in your browser security settings. This feature is only supported in Internet Explorer.</td>
</tr>
<tr>
<td>Save Changes</td>
<td>Saves the current state of the active report. When you save an active report using the browser Save as option, the report is saved in its original default state. In the browser Save as dialog box, we recommend that you select the <em>Webpage, HTML Only</em> save option to ensure that the page is saved properly. <strong>Note:</strong> To use this feature, you must have ActiveX enabled in your browser security settings. This feature is only supported in Internet Explorer.</td>
</tr>
<tr>
<td>Export</td>
<td>When active cache is enabled, exports all records or filtered only records to HTML, CSV, Excel, or PDF. <strong>Note:</strong> active cache is enabled on an active report when you click <em>Pages On Demand</em> on the Format tab, in the Navigation group. When active cache is disabled, exports all records or filtered only records to HTML, CSV, or XML (Excel). To use this feature, you must enable ActiveX in your browser security settings.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints all records or filtered only records.</td>
</tr>
<tr>
<td>Window</td>
<td>Displays reports in a cascade or separate tabs.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the active report to the default state specified in the report procedure.</td>
</tr>
</tbody>
</table>

**Active Technologies Cell Menu Options**

When you are working in active report format, the following data cell options display.
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Definition</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill down</td>
<td>Enables you to drill down one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Drill up</td>
<td>Enables you to drill up one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Auto Links</td>
<td>Displays a list of target reports that are linked to the Auto Link enabled report. This option displays for reports that have Auto Linking enabled.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enables you to add comments about data in your report. The result is an annotation that displays when you hover over it at run time.</td>
</tr>
<tr>
<td>Highlight Value</td>
<td>Enables you to highlight a particular value in your report.</td>
</tr>
<tr>
<td>Highlight Row</td>
<td>Applies highlighting to the selected row in your report.</td>
</tr>
<tr>
<td>Unhighlight All</td>
<td>Removes any applied highlighting from values or rows in your report.</td>
</tr>
<tr>
<td>Filter Cell</td>
<td>Enables you to filter the output, showing only a selected row of data.</td>
</tr>
<tr>
<td>Remove Cell Filter</td>
<td>Removes any applied cell filters.</td>
</tr>
</tbody>
</table>

**Configuring Active Technologies Report Options**

You can configure active report options, including menu options, based on user role, through the active report options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the *active report options* button. The button is available when active report or active PDF is selected as the output type.
The active report options dialog box contains the following tabs:

- General
- Menu Options
- Colors
- Advanced

**General Tab**

Use the General tab to set common properties specific to active reports.

The General tab contains the following options:

- **Display.** This area contains options to set the window to cascade or tabs, and options to freeze columns.
- **Window.** Select the window setting. The options are Cascade and Tabs.
- **Freeze Columns.** Select the columns you would like to freeze. You can also select None.
- **Page Options.** This area contains options to set the number of records per page, enable the display of page information, edit the alignment, and set the location of the page information.
  - **Records Per Page.** Select or type the number of records that you would like to display per page. The default value is 57.
  - **Display Page Information.** Select this option to display page navigation information. Clear this option to disable the display of page navigation information.
  - **Alignment.** Click the appropriate button to set the alignment of the page navigation information. Options are Left, Center, and Right.
  - **Location.** Select the location for the page navigation information. The options are Top Row and Bottom Row.

**Chart Options.** This area contains options that pertain to charts when the output format is active PDF.

**Note:** Chart Options do not display when the output format is active report.

- **Legend (check box).** Select this option to collapse the legend if necessary. Clear this option if you do not want the legend to collapse.
Legend (menu). Select the location for the legend. The choices are:

- Bottom Left
- Bottom Center
- Bottom Right

Menu Options Tab
Use the Menu Options tab to select a user type and which options to display in the menu.

The Menu Options tab contains the following options:

- **User Type.** The options are Power, Analyst, Basic, and Custom.
  - **Power.** This is the default user type. It enables all functionality.
  - **Analyst.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original, Save Changes, and Accordion.
  - **Basic.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.
  - **Custom.** If you select a combination of options that does not match one of the existing user types (Power, Analyst, Basic), the User level name that appears in the User Type field is Custom. This is not a default user type or a selectable user type. It indicates that options for this user do not match any of the existing user types.

The options available according to user type include the following:

- **Show Records.** Shows all records or specific numbers of records.
- **Freeze.** Freeze and unfreezes columns.
- **Hide/Unhide.** Hides and shows columns.
- **Export.** Exports data to HTML, CSV, Excel, or PDF if active cache is enabled, or to HTML, CSV, or XML (Excel) if active cache is disabled.
- **Sorting.** Sorts data in ascending or descending order.
- **Pivot.** Lists the fields available to create a Pivot table.
- **Window Type.** Shows windows as cascade or tabs.
- **Send as Email.** Enables you to save the current changes and send a report as email.
- **Print.** Prints all records or filtered-only records.
- **Advanced Tools.** Accesses the Chart/Rollup, Pivot, and Grid Tools.
- **Filter.** Opens the Filter Selection dialog box.
- **Calculations.** Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct, % of Total.
- **Chart.** Converts a report to a pie, line, bar, or scatter chart.
- **Visualize.** Adds data visualization bars to a report.
- **Rollup.** Performs rollup on data.
- **Comments.** Adds comments.
- **Restore Original.** Restores the active report to the default state specified in the report procedure.
- **Save Changes.** Saves the current changes.
- **Accordion.** Produces accordion reports.
- **Grid Tool.** Opens the Grid Tool dialog box.

**Colors Tab**

Use the Colors tab to select colors for various objects on the report.

The Colors tab contains the following options:

- **Page.** This area contains options to set the colors for the font and background of the page text.
- **Font.** Opens the Color dialog box, where you can select the font color.
- **Background.** Opens the Color dialog box, where you can select the background color for the page text.
- **Row Selection.** This area contains options to set the colors that appear when you point to or select a row on the report.
- **Hover.** Opens the Color dialog box, where you can select the color that the row becomes when you hold the mouse over the row.
- **Selected.** Opens the Color dialog box, where you can select the highlight color that the row becomes when you use the highlight option.
**Visual.** This area contains options to set the colors for the data visualization bars.

- **Positive.** Opens the Color dialog box, where you can select the color for a data visualization bar that represents a positive number.

- **Negative.** Opens the Color dialog box, where you can select the color for a data visualization bar that represents a negative number.

**Calculations.** This area contains options to set the colors for values in a calculation.

- **Font.** Opens the Color dialog box, where you can select the font color for the calculation.

- **Background.** Opens the Color dialog box, where you can select the background color for the calculation.

**Menu.** This area contains options to change the color of the menu.

- **Normal**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus.

  - **Background.** Opens the Color dialog box, where you can select the background color for the column menus.

  - **Border.** Opens the Color dialog box, where you can select the color for the border of the column menus.

- **Hover**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus when you point to them.

  - **Background.** Opens the Color dialog box, where you can select the background color that appears behind options on the column menus when you point to them.

**Advanced Tab**

Use the Advanced tab to control the number of rows retrieved from active cache and to add security settings.

**Note:** active cache is enabled when you select `active report` as the output type, and click `Pages On Demand` on the Format tab, in the Navigation group.

The Advanced tab contains the following options:
**active cache.** Enables a report to cache the data in a binary file and return the data to the output window in pre-set increments.

- **Rows Retrieved.** Select the number of rows retrieved in the output. The default value is 100.

**Security.** This area allows you to set a password to access the report and enable expiration by date or by days. This option is only available for the active report output.

**Note:** When setting security options for active reports, be aware that security options can be set for each individual component on the canvas, but only one password can be set for the entire document.

### Freezing Column Headings in Active Reports

When working with In-Document Analytics (Active Technologies) reports, you can freeze column headings. The Freeze option in the GUI tools allows you to define a scroll area within the data of your report and lock the column heading titles in place, enabling you to scroll through the data within the container. Report headings, footings, and grand totals are also locked, so that these also stay in view while you scroll the data in your report. This is particularly useful when you are creating a large report, for which there may be multiple pages.

When you enable the column title freeze feature and run your report, a thin scroll bar displays to the right side of the report, as shown in the following image.
When you mouse over the thin scroll bar, it turns into a full scroll bar, making it easier to scroll through your report data. This scroll bar is shown in the following image.

<table>
<thead>
<tr>
<th>Customer State</th>
<th>Cost of Goods</th>
<th>Discount</th>
<th>Gross Profit</th>
<th>Revenue</th>
<th>MSRP</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aarau</td>
<td>$6,507.745.00</td>
<td>$420.459.73</td>
<td>$2,565,432.24</td>
<td>$8,073,177.24</td>
<td>9,493,635.92</td>
<td>$26,046,450.00</td>
</tr>
<tr>
<td>Abriozzi</td>
<td>$3,124.00</td>
<td>$200.20</td>
<td>$1,140.23</td>
<td>$2,942.23</td>
<td>4,949.42</td>
<td>13,283.00</td>
</tr>
<tr>
<td>Aarau</td>
<td>$644,907.00</td>
<td>$2,748.64</td>
<td>$18,210.39</td>
<td>$65,117.28</td>
<td>80,591.03</td>
<td>196,045.00</td>
</tr>
<tr>
<td>Arçens</td>
<td>$59,687.00</td>
<td>$3,228.30</td>
<td>$2,475.81</td>
<td>$3,162.81</td>
<td>6,391.08</td>
<td>255,945.00</td>
</tr>
<tr>
<td>Acre</td>
<td>$1,012,228.00</td>
<td>$6,814.96</td>
<td>$37,065.50</td>
<td>$139,793.50</td>
<td>146,608.45</td>
<td>433,016.00</td>
</tr>
<tr>
<td>Arzana</td>
<td>$2,324.00</td>
<td>$239.58</td>
<td>$714.79</td>
<td>$3,038.79</td>
<td>3,332.37</td>
<td>6,969.00</td>
</tr>
<tr>
<td>Asburyan</td>
<td>$15,413.00</td>
<td>$1,169.96</td>
<td>$6,006.42</td>
<td>$2,019.42</td>
<td>23,299.36</td>
<td>46,438.00</td>
</tr>
<tr>
<td>Alkonkarauskasch</td>
<td>$9,506.00</td>
<td>$444.19</td>
<td>$3,746.34</td>
<td>$12,252.34</td>
<td>13,696.53</td>
<td>40,645.00</td>
</tr>
<tr>
<td>Aquasciences</td>
<td>$16,921.00</td>
<td>$6,094.37</td>
<td>$34,255.09</td>
<td>$123,176.99</td>
<td>130,288.36</td>
<td>576,714.00</td>
</tr>
<tr>
<td>Arle</td>
<td>$8,563.00</td>
<td>$422.59</td>
<td>$2,775.95</td>
<td>$9,358.95</td>
<td>9,781.54</td>
<td>26,922.00</td>
</tr>
<tr>
<td>Alcan del General Carlos Ibáñez</td>
<td>$162,647.00</td>
<td>$13,202.73</td>
<td>$59,823.51</td>
<td>$227,470.51</td>
<td>235,673.26</td>
<td>683,816.00</td>
</tr>
<tr>
<td>Aven del Grial c. Barrio del Campo</td>
<td>$14,033.00</td>
<td>$667.59</td>
<td>$6,106.03</td>
<td>$20,197.03</td>
<td>21,094.02</td>
<td>62,326.00</td>
</tr>
<tr>
<td>Akosthus</td>
<td>$32,904.00</td>
<td>$2,269.97</td>
<td>$11,002.78</td>
<td>$44,209.78</td>
<td>47,017.54</td>
<td>126,045.00</td>
</tr>
<tr>
<td>Alainsthaus county</td>
<td>$10,501.00</td>
<td>$391.49</td>
<td>$4,654.95</td>
<td>$14,555.95</td>
<td>14,947.44</td>
<td>44,456.00</td>
</tr>
<tr>
<td>Antra</td>
<td>$14,465.00</td>
<td>$265.59</td>
<td>$4,608.55</td>
<td>$19,442.55</td>
<td>19,708.54</td>
<td>58,859.00</td>
</tr>
<tr>
<td>Al Bahar al Ahmar</td>
<td>$14,254.00</td>
<td>$1,021.62</td>
<td>$3,793.31</td>
<td>$18,039.31</td>
<td>19,060.93</td>
<td>56,916.00</td>
</tr>
<tr>
<td>Al Buhayrah</td>
<td>$3,900.00</td>
<td>$165.00</td>
<td>$1,589.30</td>
<td>$5,498.30</td>
<td>5,663.36</td>
<td>16,824.00</td>
</tr>
<tr>
<td>Al Islanndyiyak</td>
<td>$8,371.00</td>
<td>$433.40</td>
<td>$2,973.58</td>
<td>$17,344.58</td>
<td>17,777.98</td>
<td>34,960.00</td>
</tr>
<tr>
<td>Al Islanndiyak</td>
<td>$4,026.00</td>
<td>$230.55</td>
<td>$1,806.95</td>
<td>$5,832.95</td>
<td>6,003.89</td>
<td>17,060.00</td>
</tr>
<tr>
<td>Al Jizia</td>
<td>$7,461.00</td>
<td>$347.50</td>
<td>$2,766.75</td>
<td>$10,227.75</td>
<td>10,574.75</td>
<td>31,377.00</td>
</tr>
<tr>
<td>Al Vitál al Jaltí</td>
<td>$4,050.00</td>
<td>$164.90</td>
<td>$1,876.94</td>
<td>$5,734.94</td>
<td>5,999.74</td>
<td>17,534.00</td>
</tr>
<tr>
<td>Alhazine</td>
<td>$1,586,841.00</td>
<td>$163,408.19</td>
<td>$620,792.77</td>
<td>$2,207,140.77</td>
<td>2,310,548.78</td>
<td>6,238,238.00</td>
</tr>
<tr>
<td>Algarra</td>
<td>$259,256.00</td>
<td>$16,364.54</td>
<td>$100,781.01</td>
<td>$360,039.01</td>
<td>376,401.61</td>
<td>1,112,046.00</td>
</tr>
<tr>
<td>Almat</td>
<td>$5,087,907.00</td>
<td>$337,102.82</td>
<td>$2,011,418.46</td>
<td>$7,099,375.46</td>
<td>7,436,480.46</td>
<td>21,972,340.00</td>
</tr>
<tr>
<td>Alberta</td>
<td>$5,985,749.00</td>
<td>$465,231.37</td>
<td>$2,381,775.68</td>
<td>$8,341,925.05</td>
<td>8,747,156.11</td>
<td>25,836,238.00</td>
</tr>
<tr>
<td>Alicante</td>
<td>$42,503.00</td>
<td>$2,271.65</td>
<td>$18,212.01</td>
<td>$60,805.01</td>
<td>63,076.67</td>
<td>186,958.00</td>
</tr>
<tr>
<td>Amstee</td>
<td>$69,453.00</td>
<td>$4,458.62</td>
<td>$37,117.59</td>
<td>$127,630.59</td>
<td>132,068.22</td>
<td>391,883.00</td>
</tr>
<tr>
<td>Ascrea</td>
<td>$29,666.00</td>
<td>$1,330.14</td>
<td>$12,519.30</td>
<td>$42,205.30</td>
<td>43,530.43</td>
<td>129,281.00</td>
</tr>
<tr>
<td>Amazones</td>
<td>$43,300.00</td>
<td>$29,405.36</td>
<td>$179,389.61</td>
<td>$632,749.61</td>
<td>652,154.91</td>
<td>1,957,058.00</td>
</tr>
<tr>
<td>Anostato Maltesiana I. Thráli</td>
<td>$19,253.00</td>
<td>$1,375.72</td>
<td>$7,085.96</td>
<td>$29,638.96</td>
<td>30,224.68</td>
<td>83,268.00</td>
</tr>
<tr>
<td>Aosta</td>
<td>$5,154,730.00</td>
<td>$332,150.06</td>
<td>$215,548.59</td>
<td>$707,371.59</td>
<td>730,708.41</td>
<td>2,388,356.00</td>
</tr>
<tr>
<td>Andersen &amp; Nicolais Islands</td>
<td>$5,455.00</td>
<td>$393.38</td>
<td>$2,349.37</td>
<td>$7,804.37</td>
<td>8,197.76</td>
<td>24,498.00</td>
</tr>
<tr>
<td>Andriam And Nicolai</td>
<td>$5,406.00</td>
<td>$373.59</td>
<td>$2,083.82</td>
<td>$7,579.82</td>
<td>7,952.71</td>
<td>23,485.00</td>
</tr>
<tr>
<td>Andrelia Ftdchek</td>
<td>$6,057.00</td>
<td>$629.57</td>
<td>$33,349.66</td>
<td>$122,211.98</td>
<td>128,412.73</td>
<td>578,638.00</td>
</tr>
</tbody>
</table>

If your report has more columns than can fit in the output container, you can employ the horizontal scroll bar at the bottom of your report.

**Note:** Scroll bars do not display if there is no scrollable data. Thus, if the data displayed fits the size of the container, scroll bars do not display.

You can enable the column heading freeze feature for In-Document Analytics reports in the GUI tools using the Freeze button on the Format tab of the ribbon, in the Navigation group. Enabling the Freeze option will add HFREEZE=ON in the stylesheet section of the report procedure, as shown in the following example.
Once you have enabled the column heading freeze feature, you must run your report to view the report with scroll bars.

**Procedure:** **How to Freeze Column Titles in Reports**

You can freeze column headings in your In-Document Analytics (Active Technologies) reports.

1. Open InfoAssist.
2. Build your report.
3. Set the output format to Active Report (AHTML).
4. On the **Format** tab, in the **Navigation** group, click **Freeze**.
5. Run the report to view the frozen column titles.
6. A scrollbar displays, enabling you to scroll through your data, vertically, as shown in the following image.

<table>
<thead>
<tr>
<th>Customer</th>
<th>State Province</th>
<th>Cost of Goods</th>
<th>Discount</th>
<th>Gross Profit</th>
<th>Revenue</th>
<th>MSRP</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aarjai</td>
<td></td>
<td>$6,507,745.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Habari</td>
<td></td>
<td>$3,154.00</td>
<td></td>
<td></td>
<td>$1,140.23</td>
<td>$4,294.23</td>
<td>4,494.43</td>
</tr>
<tr>
<td>Abuzzo</td>
<td></td>
<td>$46,807.00</td>
<td>$2,746.54</td>
<td>$18,210.78</td>
<td>$66,017.28</td>
<td>67,933.90</td>
<td>200,045.11</td>
</tr>
<tr>
<td>Acces</td>
<td></td>
<td>$59,887.00</td>
<td>$3,228.30</td>
<td>$23,475.61</td>
<td>$83,162.81</td>
<td>89,381.05</td>
<td>255,545.05</td>
</tr>
<tr>
<td>Acreative</td>
<td></td>
<td>$102,228.00</td>
<td>$6,116.96</td>
<td>$27,965.50</td>
<td>$130,752.00</td>
<td>146,008.40</td>
<td>423,076.41</td>
</tr>
<tr>
<td>Adalara</td>
<td></td>
<td>$2,324.00</td>
<td></td>
<td></td>
<td>$714.79</td>
<td>$3,038.79</td>
<td>3,354.37</td>
</tr>
<tr>
<td>Adyraman</td>
<td></td>
<td>$15,412.00</td>
<td>$1,195.60</td>
<td>$6,049.42</td>
<td>$22,010.42</td>
<td>23,289.29</td>
<td>69,423.11</td>
</tr>
<tr>
<td>Afsharvar</td>
<td></td>
<td>$9,504.00</td>
<td></td>
<td></td>
<td>$13,345.34</td>
<td>13,686.54</td>
<td>40,495.46</td>
</tr>
<tr>
<td>Agazalente</td>
<td></td>
<td>$99,821.00</td>
<td>$2,091.27</td>
<td>$24,255.99</td>
<td>$123,176.99</td>
<td>128,266.20</td>
<td>379,719.70</td>
</tr>
<tr>
<td>Achi</td>
<td></td>
<td>$6,583.00</td>
<td></td>
<td></td>
<td>$2,775.95</td>
<td>$9,358.95</td>
<td>9,781.54</td>
</tr>
<tr>
<td>Almagen</td>
<td></td>
<td>$162,647.00</td>
<td>$13,202.73</td>
<td>$50,825.51</td>
<td>$222,471.51</td>
<td>235,673.20</td>
<td>693,836.10</td>
</tr>
<tr>
<td>Alcon del Orinoco del Cerro</td>
<td>$14,633.00</td>
<td>$887.58</td>
<td>$6,164.63</td>
<td>$25,167.03</td>
<td>21,964.62</td>
<td>62,326.27</td>
<td></td>
</tr>
<tr>
<td>Alvarado</td>
<td></td>
<td>$32,904.00</td>
<td>$2,590.07</td>
<td>$11,605.78</td>
<td>$44,505.78</td>
<td>47,017.84</td>
<td>138,545.47</td>
</tr>
<tr>
<td>Akensho</td>
<td></td>
<td>$10,501.00</td>
<td>$391.49</td>
<td></td>
<td>$4,954.95</td>
<td>$14,555.95</td>
<td>14,947.44</td>
</tr>
<tr>
<td>Akte</td>
<td></td>
<td>$14,418.00</td>
<td>$255.99</td>
<td>$4,961.55</td>
<td>$19,442.55</td>
<td>19,706.54</td>
<td>58,059.65</td>
</tr>
<tr>
<td>Al Bahrein</td>
<td></td>
<td>$14,254.00</td>
<td>$1,021.62</td>
<td>$3,785.31</td>
<td>$16,030.31</td>
<td>19,060.93</td>
<td>56,161.17</td>
</tr>
<tr>
<td>Al Biruni</td>
<td></td>
<td>$3,500.00</td>
<td>$165.00</td>
<td>$1,988.30</td>
<td>$5,498.30</td>
<td>5,663.30</td>
<td>16,824.90</td>
</tr>
<tr>
<td>Al Ismailiyah</td>
<td>$8,971.00</td>
<td>$433.49</td>
<td>$2,973.58</td>
<td>$11,344.58</td>
<td>11,777.55</td>
<td>24,900.54</td>
<td></td>
</tr>
<tr>
<td>Al Ismailiya</td>
<td></td>
<td>$4,626.00</td>
<td>$130.85</td>
<td>$1,806.95</td>
<td>$5,032.95</td>
<td>5,063.00</td>
<td>17,865.55</td>
</tr>
<tr>
<td>Al Jazirah</td>
<td></td>
<td>$7,461.00</td>
<td></td>
<td></td>
<td>$2,766.75</td>
<td>$10,237.75</td>
<td>19,374.75</td>
</tr>
<tr>
<td>Al Yena Al Jadid</td>
<td>$4,458.00</td>
<td>$194.00</td>
<td>$1,876.84</td>
<td>$5,734.84</td>
<td>5,999.74</td>
<td>17,054.39</td>
<td></td>
</tr>
<tr>
<td>Alabama</td>
<td></td>
<td>$1,568,341.00</td>
<td>$103,406.19</td>
<td>$260,789.77</td>
<td>$2,207,140.77</td>
<td>2,310,548.78</td>
<td>6,826,337.65</td>
</tr>
<tr>
<td>Bakasso</td>
<td></td>
<td>$259,256.00</td>
<td>$16,384.64</td>
<td>$100,781.61</td>
<td>$360,030.61</td>
<td>376,403.61</td>
<td>1,112,846.27</td>
</tr>
<tr>
<td>Beklada</td>
<td></td>
<td>$5,957,256.00</td>
<td>$337,192.62</td>
<td>$2,011,411.46</td>
<td>$7,990,317.46</td>
<td>7,436,490.40</td>
<td>21,773,040.14</td>
</tr>
<tr>
<td>Benin</td>
<td></td>
<td>$5,960,749.00</td>
<td>$405,231.37</td>
<td>$2,361,176.68</td>
<td>$8,341,925.68</td>
<td>8,747,156.11</td>
<td>25,362,336.84</td>
</tr>
<tr>
<td>Bolivia</td>
<td></td>
<td>$42,593.00</td>
<td>$2,271.65</td>
<td>$18,122.61</td>
<td>$60,865.01</td>
<td>63,076.67</td>
<td>186,058.34</td>
</tr>
<tr>
<td>Argentina</td>
<td></td>
<td>$50,943.00</td>
<td>$2,455.67</td>
<td>$17,724.76</td>
<td>$69,307.65</td>
<td>71,060.82</td>
<td>219,061.09</td>
</tr>
</tbody>
</table>

Note: If you have numerous columns in your report, you can employ the horizontal scrollbar at the bottom of the report.

Creating an Active Technologies Chart

An active chart is a chart that is designed for offline analysis. For more information, see Active Technologies Report Overview on page 13.

Note: Active Technologies supports the use of HTML5 extensions, which are user-supplied, custom chart types that access resources external to Web Query.WebFOCUS. For details on the structure of an extension and the steps for creating your own, as well as the process for adding it to the chart library, see the Adding Your Own Chart Types to the Chart Library chapter in the Creating HTML5 Charts With WebFOCUS Language manual.

Procedure: How to Create an Active Technologies Chart

With InfoAssist in Chart mode, you can perform this procedure in Query Design view or Live Preview.

1. On the status bar, in the Output Types menu, click active report or active PDF.
2. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.

The chart appears on the canvas.
3. Populate the chart with your data in one of the following ways:

- Drag the dimension fields and measure fields onto the chart.
- Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

The following image shows an HTML5 pie chart that displays the sum of the values in the Quantity Sold field by Product Category.

**Active Technologies Options for Charts**

Options for an active chart are described in the following table.

**Note:** For charts that employ the new attribute syntax, only the following four icons display: More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the Remove Filter icon displays.
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>More Options</td>
<td><strong>New.</strong> Creates a new instance of the chart. This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td></td>
<td><strong>Group By (X).</strong> Changes groups by the horizontal sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Add (Y).</strong> Adds a vertical sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>X-Axis.</strong> Specifies a measure or dimension sort field. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Y-Axis.</strong> Specifies a measure. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Arrange By.</strong> Specifies the marker color. The marker color depends on the field assigned to the color attribute. If no field is assigned to this category, then all of the markers will be the same color. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Export to.</strong> Exports to Excel, Word, or PowerPoint.</td>
</tr>
<tr>
<td></td>
<td><strong>Stacked.</strong> Stacks the risers on top of each other, with the length of each riser representing the data value. Applies to column charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Top.</strong> Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top. Applies to pie charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend.</strong> Draws a trendline and equation label for an individual series. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Chart/Rollup Tool.</strong> Opens the Chart/Rollup Tool, which you can use to select multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool contains a list of columns available in the active report and Group By and Measure sort fields. Drag the columns into the desired sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When working with the Chart/Rollup Tool for active charts (specifically those with the new chart attribute syntax), the Series tab is not supported. It is available with charts that are created with tabular reports or stand-alone charts that do not use the new chart attribute syntax.</td>
</tr>
<tr>
<td></td>
<td><strong>Restore Original.</strong> Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Column</td>
<td>Displays data as a column chart.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pie</td>
<td>Displays data as a pie chart.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-pie.png" alt="Pie Chart" /></td>
</tr>
<tr>
<td>Line</td>
<td>Displays data as a line chart.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-line.png" alt="Line Chart" /></td>
</tr>
<tr>
<td>Scatter</td>
<td>Displays data as a scatter chart.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-scatter.png" alt="Scatter Chart" /></td>
</tr>
<tr>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-rollup.png" alt="Rollup Chart" /></td>
</tr>
<tr>
<td>Advanced Chart</td>
<td>Opens the Chart/Rollup Tool.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-advanced.png" alt="Advanced Chart" /></td>
</tr>
<tr>
<td>Original Chart</td>
<td>Restores the active chart to the chart type specified in the report procedure.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-original.png" alt="Original Chart" /></td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup). This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-lock.png" alt="Lock/Unlock" /></td>
</tr>
<tr>
<td>Aggregation</td>
<td>Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and Distinct. The default value is Sum.</td>
</tr>
<tr>
<td></td>
<td><img src="chart-aggregation.png" alt="Aggregation" /></td>
</tr>
</tbody>
</table>
### Option Definition

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Filter</td>
<td>Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area of the chart and then clicking the <em>Filter Chart</em> or <em>Exclude from Chart</em> option from the chart tooltip.</td>
</tr>
</tbody>
</table>

### Usage Notes for Active Technologies Charts

If you are working with an AHTML chart that does not have the new chart properties (specifically, non-bucket AHTML charts), you will encounter problems if you change the chart type to one of the following chart types using the Advanced Chart tool at run time:

- Tag Cloud
- Funnel
- Pyramid
- Waterfall
- Histogram
- Radar Line
- Radar Area
- 3D Area

By default, these chart types are hidden in the Advanced Chart tool when the original chart is an AHTML bucket chart. These chart types are available under the following circumstances:

- When the original chart is a non-bucket chart
- When the chart is created from a tabular report

### Creating an Active Technologies Dashboard

You can create an active dashboard by inserting multiple content types, such as reports, charts, images, and text, into a document. An active dashboard will run any report or chart using the active output format, even if the report or chart itself is not in active output format.

You can also insert active dashboard prompts into a document to act as filters for the reports and charts on the dashboard. You can cascade (chain) prompts to populate them based on the selections from the previous prompts.
The output format of the active dashboard must be active report or active PDF in order to add active dashboard prompts.

**Active Technologies Dashboard Prompts**

The active dashboard prompts group contains buttons that insert active dashboard prompts into your dashboard. This group is only visible when the output format of the dashboard is set to active report or active PDF. You can access the active dashboard prompts on the Insert tab, in the active dashboard prompts group.

The following are the types of active dashboard prompts that you can use to apply filters to an active dashboard:

- **Drop Down.** Inserts a drop down prompt placeholder in the upper-left corner of the canvas.
- **List.** Inserts a list prompt placeholder in the upper-left corner of the canvas.
- **Checkbox.** Inserts a check box prompt placeholder in the upper-left corner of the canvas.
- **Radio Button.** Inserts a radio button prompt placeholder in the upper-left corner of the canvas.
- **Text.** Inserts a text area prompt placeholder in the upper-left corner of the canvas.

**Note:** The display of values populated in active dashboard prompts is dependent on the data setting. For example, if sample data is turned on, then active dashboard prompts will show sample data, such as:

- WF_RETAIL1
- WF_RETAIL2
- WF_RETAIL3

**Target Reports**

When you bind a field to an active dashboard prompt, the default target report is the report from which you dragged the field. You can add or remove target reports from an active dashboard prompt through the active dashboard properties dialog box.

A report must meet one of the following requirements to be a target report:

- The report must contain a field with the same name as the source field (actual field name or AS name).
- The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title and the title is changed, the report is automatically removed as a target.
**Procedure:** How to Add an Active Technologies Dashboard Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and binding a single prompt to one of the fields of the report.

With InfoAssist in Document mode:

1. On the status bar, in the Output Types menu, accept the default output type (active report), or click **active PDF**.
2. On the **Insert** tab, in the **Reports** group, click **Report**.
   
   A placeholder appears on the canvas.
3. Drag fields onto the canvas, or into the Query pane, to create the report and start building the dashboard.
4. On the **Insert** tab, in the **active dashboard prompts** group, select a dashboard prompt to insert into the document.
   
   An active dashboard prompt appears in the upper-left corner of the canvas. If the report is located in the upper-left corner of the canvas, you will have to drag the prompt off the report.
5. Select the report and bind one of its data source fields to the prompt in one of the following ways:
   
   - **Query pane**: Select the report. From the Query pane, drag the field that you want to bind onto the prompt.
   - **Report on the canvas**: Click the report on the canvas. You can now edit it. Highlight the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

**Note:** Once an active dashboard prompt is added to the canvas, the document is locked in an active output format. You cannot change the active report or active PDF format if there are prompts present on the canvas. To switch to a non-active output format, you must remove all prompts.

**Using Multiple Reports as Targets and Sources**

You can add multiple reports and charts to an active dashboard. Each report can have multiple prompts associated with it.
**Procedure:**  How to Build a Dashboard With Multiple Reports as Targets and Sources

The following procedure describes how to set up active dashboard prompts for two reports on a dashboard. In the example that is used, the first report contains information about the categories of electronics products sold in various regions. The Product,Category field will be bound to a group of radio buttons. Each radio button will represent a particular product category of electronics. When you select a radio button for a product category, for example, Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of electronics consumers. The Gender field will be bound to a drop-down list. The list will display the values, F (female) and M (male). When you select a gender from the drop-down list, the report will be filtered by your selection.

1. Open InfoAssist in Document mode using the wf_retail_lite Master File.

2. Create an active dashboard by adding two reports with the following components, respectively:

   **Report 1:**
   - Product,Category
   - Store,Business,Region
   - Discount
   - Gross Profit

   **Report 2:**
   - Gender
   - Customer,Continent
   - Product,Category

3. On the Insert tab, in the active dashboard prompts group, add the following active dashboard prompts to the dashboard, positioning them relative to each respective report.

   - **Radio Button:** This prompt will be used for Report1.
   - **Drop Down:** This prompt will be used for Report2.

   For more information on working with active dashboard prompts, see *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 42.

4. Right-click the radio button active dashboard prompt for which you want to bind a field to and click *Properties*.

   The active dashboard properties dialog box opens.
The Prompts list displays the two prompts (for example, radiobutton_1 and combobox_2) that were added to the dashboard in Step 3.

5. From the Report drop-down menu, select the report that contains the field to which you want to bind an active dashboard prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for the region report (Report 1), as shown in the following image.

![Active Dashboard Properties](image)

The next step describes how to bind the Product,Category field from the region report to the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the active dashboard prompt.
In this example, the Product,Category field has been selected for the radio button list (radiobutton_1), as shown in the following image.

**Note:** You can optionally specify an ascending or descending sort order for the current scenario.

7. Click **OK**.

The prompt is now bound to the field on the dashboard.
In the following image, the radio button list is bound to the Product,Category field. It displays all product categories by which you can filter the report.

The following steps describe how to bind the Gender field in the gender report (Report2) to the drop-down list prompt.

8. Right-click the Drop Down active dashboard prompt for which you want to bind a field and click Properties.

The active dashboard properties dialog box opens again.

Notice that combobox_2, the prompt selected on the dashboard, is selected in the Prompts list.
9. From the Report drop-down menu, select the report (Report2) that contains the field to which you want to bind an active dashboard prompt.

The next step describes how to bind the Gender field from the gender report to the drop-down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the active dashboard prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets list and Report1 (region report) appears in the Candidate Reports list.

**Note:** To move a report from the Candidate Reports list box to the Targets list box, select it and click the *Add to List* arrow. To remove a report from the Targets list box, select it and click the *Remove from List* arrow. You can select multiple reports by holding down the Ctrl key and clicking each one.

11. Click *OK*.

The prompt is now bound to the Gender field on the dashboard. You can now filter the gender report by female or male, as shown in the following image.
Procedure: How to Change the Field

You can change the field to which the active prompt is bound.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active prompt to a field.

2. Right-click the active dashboard prompt that you want to configure, and click Properties. The active dashboard properties dialog box opens.

3. From the Field menu, select a different field.

A warning message alerts you that changing the source field for the prompt will remove the existing prompt and any dependent (child) prompts from the cascades.

4. Click OK to close the warning.

5. Click OK to close the active dashboard properties dialog box.

The active dashboard prompt is updated with the new source field.
**Procedure: How to Change the Filter Condition**

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active dashboard prompt to a field, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 42.

2. Right-click the active dashboard prompt that you want to work with, and from the shortcut menu, select *Properties*.

   The active dashboard properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the active dashboard prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater than, and Greater than or equal to.

4. Click *OK*.

   The filter condition is applied to the active dashboard prompt.

**Procedure: How to Add Multiple Prompts to a Dashboard**

1. Create an active dashboard in Document mode, or open an existing dashboard containing at least one report, and add at least two active dashboard prompts, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 42.

2. Bind the fields to prompts that you have added, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 42.

**Procedure: How to Cascade Prompts**

When you have more than one prompt on the canvas, you can cascade prompts to populate them based on the selections of the previous prompts. Cascading prompts have a parent-child relationship, in which the parent filters the available options of the child.

An active prompt can be the parent of more than one other prompt, but cannot be a child of more than one prompt.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind at least two active prompts to fields.

2. Right-click the active dashboard prompt that you want to configure, and click *Properties*.

   The active dashboard properties dialog box opens.

3. Click *Cascades*.

   By default, a cascade named Cascade1 appears in the Cascades section of the active dashboard properties dialog box.

   ![You can click the Create a new cascade button to create a new cascade.](image)
You can click the Delete selected cascade button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.
   
   **Note:** You can remove prompts from the Selected Prompts list box by selecting them and clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and 6.

   By default, the hierarchy of the prompts is determined by the order in which they are added to the Selected Prompts list. The cascade of the prompts is from top to bottom. The prompts that come first in the Selected Prompts list are the parents of the lower prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt list box and clicking the Move Up and Move Down arrows.

9. Click OK.

   The cascade is created.

10. Run the report.

    **Note:** If you set up more than one cascade, the cascade that you interact with last is the one that filters the report.
Active Technologies for Mobile Web Apps

This topic describes Active Technologies features and functions available on mobile and gesture-enabled devices with multi-touch capability, such as the Apple® iPhone® and Apple iPad®.

In this chapter:

- Requirements for Mobile Web Apps
- Mobile Web Apps Features
- Standard Gesture Support
- Running an Active Technologies Report on a Mobile Device
- Running an Active Technologies Dashboard on a Mobile Device

Requirements for Mobile Web Apps

Apple requires that any web content that is accessed from an iPhone app is compatible with, and optimized for display on, all Apple iOS-based devices. Active Technologies comply with web standards and are compatible with the Apple Safari browser.

For additional information, see Web Browser Support for WebFOCUS, which can be accessed by clicking on the following URL:

https://techsupport.informationbuilders.com/tech/wbf/wbf_tmo_027.html

Note: Some browsers may function differently depending on the operating system. See the WebFOCUS Release Notes for detailed information on known issues related to browser version or configuration.

Mobile and Tablet Device Support Information

The following apply to Active Technologies for mobile web apps.

- Active Technologies for Adobe Flash Player and for PDF are not supported on devices that do not support Adobe® Flash® Player. Only Active Technologies HTML JavaScript charts are available on such devices.
Running an AHTML report with more than 30,000 records may cause the mobile Safari browser to close on the Apple iPad. To handle a large set of data when using Safari on iPad, turn on the active cache feature.

**Mobile Web Apps Features**

The following features apply to Active Technologies implemented on mobile devices.

- Active Technologies check for the screen size of the device at run time. If the height of the screen is less than 500 pixels, Active Technologies assume that the report or dashboard is running on a mobile device and the mobile user interface is used. This feature applies when the device is in either portrait or landscape mode.

- By default, Active Technologies use tab window navigation, familiar to most users. In tab window navigation, open windows are represented by tabs across the top of a report. Tap a tab to navigate between windows.

  ![Report, Chart, Filter]

**Important:**

- In full-screen web app view, Rollup and Pivot tables created from Rollup menu options are not displayed. You can view them when you switch to the original active report view.

- In full-screen web app view, the totals in a Pivot table may appear misaligned when switching BY and ACROSS columns in the Pivot table.

**Standard Gesture Support**

Active Technologies support the following standard interactive gestures that are used on a multi-touch screen.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap</td>
<td>To press or select a control or item (analogous to a single mouse click).</td>
</tr>
<tr>
<td>Drag</td>
<td>To move columns left and right or up and down slowly when an active report is in a grid in full-screen web app view.</td>
</tr>
<tr>
<td>Flick</td>
<td>To move columns left and right or up and down quickly when an active report is in a grid in full-screen web app view.</td>
</tr>
<tr>
<td>Gesture</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Swipe</td>
<td>To page forward or backward in a pagination bar when an active report is in a grid in full-screen web app view.</td>
</tr>
<tr>
<td>Double tap</td>
<td>To zoom in and center a block of content or an image. If you are already zoomed in, a double tap zooms out. You can also double tap the screen to hide both the top and bottom toolbars, as well as the pagination bar. Double tap the screen again to show both toolbars and the pagination bar.</td>
</tr>
</tbody>
</table>

The following table lists and describes gestures specific to mobile charts.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap</td>
<td>The tap gesture is used to select or highlight an item, such as a riser, and show its tooltip (analogous to pausing the mouse over an object).</td>
</tr>
<tr>
<td>Long touch</td>
<td>Touching and holding an item, such as a riser, is used to trigger a drop-down menu on events that support it (analogous to a single mouse click).</td>
</tr>
<tr>
<td>Short drag</td>
<td>Can be used interchangeably with long drag for either scrolling (on charts with scroll bars or moving around on maps) or for marquee data selection. On charts that include both scrolling and marquee selections, a short drag will scroll and a long drag will do a marquee data selection.</td>
</tr>
<tr>
<td>Long drag</td>
<td>Can be used interchangeably with short drag for either scrolling (on charts with scroll bars or moving around on maps) or for marquee data selections. Note that if a chart supports only scrolling or only marquee selections, then a long drag does nothing. On charts that include both scrolling and marquee selections, a short drag will scroll and a long drag will do a marquee data selection.</td>
</tr>
</tbody>
</table>
The following image shows a tooltip that appears when you tap on a riser (for example, the pie slice with the largest data value).

The following image shows the options available for a marquee data selection, also known as lassoing (for example, when a long drag is performed over the two pie slices with the largest data values).
Running an Active Technologies Report on a Mobile Device

The following image shows a sample active report that is running on an iPad in full-screen web app view.

You can use the icons on the pagination bar of the grid in an active report to:

- Adjust the viewing mode, which can be either full-screen web app view or original active report view.
- Position the pagination bar at the top or bottom of the report.

By tapping the column title of a report, you can access the report column drop-down menu to refine the data in different ways and manipulate the way that you present it.

You can also use the icons on the chart, rollup, or pivot tool bar of an active report to adjust the viewing mode, which can be either full-screen web app view or original active report view.

Adjusting the Views

Tap the Fullscreen View icon to display the report in full-screen web app view mode. Full-screen web app view means that the report is presented as a gesture-enabled web app with the features and functionalities customized for mobile and touch-screen devices. This is the default view for the display of a report on mobile and multi-touch devices.
In full-screen web app view, tap the Original View icon to restore the report to its original active report view. Original active report view means that the report is presented as a regular active report running inside the browser. All the functionalities of active reports in the desktop browser are intact in this mode, except the window display option, which is set to Tabs instead of Cascade by default to accommodate devices with small screen sizes.

Adding an Active Technologies Report or Dashboard to the Home Screen

For easy access, you can add an active report or dashboard to the Home screen of your device. When an active report or dashboard is added to the Home screen, it will create an icon of the report or dashboard. The user can tap the icon to access the active report or dashboard instead of entering its URL in the device browser. When the active report or the dashboard is opened from the Home screen, it will connect to WebFOCUS to retrieve the most up-to-date information. Accessing active reports and dashboards from the icon provides more space to view reports or dashboards on devices with small screen sizes. There will be no browser toolbars to take up screen space.

To add an active report or dashboard to the Home screen on the iPhone and iPad, open an active report or dashboard in the browser and then tap the Action icon at the bottom of the screen. Tap the Add to Home Screen option.

To add an active report or dashboard to the Home screen on Android devices, open an active report or dashboard in the browser and open the menu options. Tap Add shortcut to Home. Depending on your device, you may need to tap Add bookmark first. In this case, go to the Bookmarks list and touch and hold the bookmark you just added to bring up the Add shortcut to Home option.

Hiding and Showing the Pagination Bar and the Top and Bottom Toolbars

In full-screen web app view, you can hide the pagination bar and the top and bottom toolbars of the grid and chart. This is done so that there is more space to view the active reports and charts on devices with small screen sizes.

To do this:

1. Click the Fullscreen View icon to display the report in full-screen web app view, if it is not already in that view.
2. In the grid cell data area or in a chart, double tap to hide the pagination bar and the top and bottom toolbars.
3. In the grid cell data area or in a chart, double tap to show the pagination bar and the top and bottom toolbars.
Navigating Between Pages

To navigate between the pages of an active report:

1. Click the Fullscreen View icon to display the report in full-screen web app view if it is not already in that view.
2. On the pagination bar, swipe from right to left to display the next page of the report.
3. On the pagination bar, swipe from left to right to display the previous page of the report.

Accessing the Report Column Drop-Down Menu

The following image shows a sample report column drop-down menu for a numeric data column in full-screen web app view.

The menu option Visualize is available only for numeric data. The menu options Show Columns and Show All are available only when there are hidden columns in the report. The menu options Freeze Column and Unfreeze All are available only in full-screen web app view.
**Procedure:**  How to Access the Report Column Drop-Down Menu

1. On a run-time tabular report (grid), tap once on a column title.
   The report column drop-down menu is displayed, with a selection of options.

2. Tap the desired menu option. An arrow to the right of a menu option means that there is an additional menu associated with that option. The options and their associated menus are described in the topics that follow.

3. To remove the report column drop-down menu, tap Cancel.

**Sorting Data**

You can sort data in any column of an active report in ascending or descending order.

From the report column drop-down menu, tap **Sort Ascending** to sort the data in ascending order.

From the report column drop-down menu, tap **Sort Descending** to sort the data in descending order.

**Filtering Data**

On a run-time active report, locate and tap the title of the column that you wish to filter. From the report column drop-down menu, tap **Filter** or touch the right arrow for the Filter menu option. The Filter menu is displayed, specifying the default filter condition and default values for the selected column in the existing report.
The following image shows a sample Filter menu. In this example, the default condition is Equals and the default value is Alabama. Alabama is the first value in the existing report for the selected column.

The menu retains any previous filters that were applied to this column of the report.

You can:

- Tap Done once to see the result of the default condition and values. The filtered report is automatically generated, and a new Filter tab is appended after the Report tab and any other existing tabs. On the new Filter tab, you can change the default condition and values to customize the filter for your reporting needs.

- You can also tap the Condition and Values drop-down dialog box to change the filter condition or values before tapping the Done button.

- Tap Clear All to remove all the filters that are currently applied to this report.
Using the Filter Tab

The following image shows a sample Filter tab for an active report (grid).

![Filter Selection](image)

The Filter tab shows all the filters that are applied to the report.

An individual filter applies only to the specific report from which the filter was created or to which the filter was added. You can scroll up and down the list to view all the individual filters.

From the Filter tab, you can do the following.

- Tap a drop-down list to change the filter condition or values. An asterisk next to a value (for example, next to Alabama in the preceding example) means that multiple values define the condition.

- Tap the Delete icon to remove an individual filter from the report.

- Tap Operator: AND to change the condition (operator) between all existing filters from AND (the default) to OR.

- Tap Add Condition to define a new filter.

- Tap Filter to apply a modified or new filter and generate the new report.

- Tap Highlight to apply highlight to the filtered values in the report.

- Tap Clear All to remove all the filters that are currently applied to the report.

Calculating Data

From the report column drop-down menu, tap Calculate or touch the right arrow for the Calculate menu option to display a menu from which you can apply a calculation to the selected column.
The following image shows the Calculate menu for a numeric data column. The calculations that are available on the menu depend on the data type of the selected column: numeric, alphanumeric, or date.

<table>
<thead>
<tr>
<th>Back</th>
<th>Calculate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Clear All</td>
<td></td>
</tr>
<tr>
<td>Sum</td>
<td></td>
</tr>
<tr>
<td>Avg</td>
<td></td>
</tr>
<tr>
<td>Min</td>
<td></td>
</tr>
<tr>
<td>Max</td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>Distinct</td>
<td></td>
</tr>
<tr>
<td>% of Total</td>
<td></td>
</tr>
</tbody>
</table>

You can do the following:

- Tap a calculation type in the list. A new report is generated on the Report tab. The calculated result for the selected column is displayed at the location in the grid specified in the WebFOCUS report procedure. Depending on the size of the screen that you are using, the calculated result may be displayed over two lines.
- From the report column drop-down menu, tap Calculate and then tap Clear to remove the calculation that was last applied to the report.
- From the report column drop-down menu, tap Calculate and then tap Clear All to remove all the calculations that are currently applied to the report.

### Viewing Data as a Chart

When you run an active report on an iPad, you can tap Chart from the report column drop-down menu and tap the right arrow, or touch the right arrow for the Chart menu option to display a menu that specifies the default value for the type of chart that will be displayed and the default aggregation (calculation) that will be used to draw the chart. Also listed are the columns that are available for display on the X-axis of the chart (the Group By columns).
The following image shows a sample Chart menu. In this example, the default chart type is Bar and the default aggregation is Sum, for the selected numeric data column. Columns that can be displayed on the X-axis (Group By columns) are listed on the menu.

You can access the same menu from the Advanced Chart icon at the bottom of the screen if you are already in a chart in full-screen web app view. This menu and icon apply to the WebFOCUS HTML5 chart engine (ARGRAPHENGINE=JSCHART).

```
<table>
<thead>
<tr>
<th>Back</th>
<th>Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Chart Type</td>
<td>Bar &gt;</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Sum</td>
</tr>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Product Type</td>
<td></td>
</tr>
<tr>
<td>Product Name</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods</td>
<td></td>
</tr>
</tbody>
</table>
```

Tap a Group By column for the X-axis to automatically generate a chart that is the result of the default values and the selected X-axis column. The chart is displayed in tab view, with a new Chart tab appended after the Report tab and any other existing tabs.

The chart is generated in full-screen web app view by default, if you are in that view.

Alternatively, you can tap the Chart Type menu to change the chart type or tap the Aggregation drop-down menu to change the calculation type, before selecting the Group By column to generate the new chart.
Tapping the Chart Type menu displays the Chart Type options, as shown in the following image.

<table>
<thead>
<tr>
<th>Back</th>
<th>Chart Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar</td>
<td>&gt;</td>
</tr>
<tr>
<td>Column</td>
<td>&gt;</td>
</tr>
<tr>
<td>Pie</td>
<td>&gt;</td>
</tr>
<tr>
<td>Line</td>
<td>&gt;</td>
</tr>
<tr>
<td>Area</td>
<td>&gt;</td>
</tr>
<tr>
<td>Scatter</td>
<td>&gt;</td>
</tr>
<tr>
<td>Other</td>
<td>&gt;</td>
</tr>
</tbody>
</table>
You can now tap a category, such as Pie, and then tap the Donut chart type that will be used to display the chart. The following image shows some of the charts in the Pie category.

If you are using the WebFOCUS Mobile Faves for iOS app, it may take a moment for the chart types in a chart category to be displayed. There is no JavaScript engine that renders JavaScript faster inside the iOS app, and JavaScript cannot take advantage of features such as hardware acceleration.

On the new Chart tab, you can change the values to customize the chart for your reporting needs. You can also manipulate the way that you present the data.
Using the Active Technologies Chart Menu

The active chart menu and its submenus allow you to change the columns used in the chart or rollup table or select multiple columns from those available in the report, including hidden and NOPRINT columns.

The following image shows the active chart menu.

![Chart Menu]

You can:

- Tap **New** to create a copy of the same chart on a new Chart tab.
- Tap **Original View** or **Fullscreen** to display the chart in the desired viewing mode.
- Tap **Group By (X)** to change the column selected for the X-axis (the Group By field) or add any column available in the report, including hidden and NOPRINT columns. On the Group By (X) submenu, values used in the existing chart are displayed at the top of the column names and are selected (checked) by default. A newly selected X-axis column is displayed at the top of the column names and is checked.
For a bar chart, tap Stacked to create a stacked AHTML bar chart.

The following image shows a sample Group By (X) submenu. The column Product Type is used as the X-axis in the existing chart.

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Chart tab displays the modified chart, reflecting all the changes.

- Tap Add (Y) to change the column selected for the Y-axis or add any column available in the report, including hidden and NOPRINT columns. On the Add (Y) submenu, the values used in the existing chart are selected by default.
The following image shows a sample Add (Y) submenu. The column Cost of Goods is used as the Y-axis in the existing chart.

<table>
<thead>
<tr>
<th>Back</th>
<th>Add (Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>Product Type</td>
<td></td>
</tr>
<tr>
<td>Product Name</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods</td>
<td>✓</td>
</tr>
</tbody>
</table>

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Chart tab displays the modified chart, reflecting all the changes.

**Viewing Data in a Rollup Table**

Tap *Rollup* or touch the right arrow for the Rollup menu option to display a menu that specifies the default aggregation (calculation) that will be used to generate the rollup table. Also listed are the Group By columns that are available for display in the rollup table.
The following image shows a sample Rollup menu. In this example, the default aggregation is Sum for a numeric data column. The available Group By columns are listed on the menu.

Tap a Group By column to automatically generate a rollup table that is the result of the default aggregation value and the selected column. You must select at least one Group By column. After you select a column, the rollup table is displayed in tab view, with a new Rollup tab appended after the Report tab and any other existing tabs.

The rollup table is generated in full-screen web app view by default, if you are in that view.

You can also tap the Aggregation drop-down menu to change the calculation type before selecting the Group By field to generate the new rollup.

On the new Rollup tab, you can change the values to customize the rollup table for your reporting needs, making it more complex as required for analysis. You can also manipulate the way that you present the data.
Using the Rollup Tab

The following image shows a sample Rollup tab.

Beneath the rollup table is the chart or rollup tool bar, which contains the icons described in the following table.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>More Options</td>
<td>Displays the active chart or rollup menu. For details, see Using the Rollup Menu on page 71.</td>
</tr>
<tr>
<td></td>
<td>Column</td>
<td>Changes the report to a column chart.</td>
</tr>
<tr>
<td></td>
<td>Pie</td>
<td>Changes the report to a pie chart.</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>Changes the report to a line chart.</td>
</tr>
<tr>
<td></td>
<td>Scatter</td>
<td>Changes the chart type to scatter.</td>
</tr>
<tr>
<td></td>
<td>Scatter</td>
<td>Scatter charts are available for numeric columns.</td>
</tr>
<tr>
<td></td>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td></td>
<td>Advanced Chart</td>
<td>Opens the chart tool to change the chart type.</td>
</tr>
<tr>
<td></td>
<td>Original Chart</td>
<td>Restores the current chart type to the initial chart type that was displayed.</td>
</tr>
<tr>
<td></td>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup).</td>
</tr>
<tr>
<td></td>
<td>Aggregation</td>
<td>Changes the aggregation method.</td>
</tr>
</tbody>
</table>
Using the Rollup Menu

The rollup menu and its submenus allow you to select multiple columns from those available in the report, including hidden and NOPRINT columns.

The following image shows the rollup menu.

![Rollup Menu Image]

To access the Rollup menu, tap the More Options icon with a rollup table open.

You can:

- Tap **New** to create a copy of the same rollup table on a new Rollup tab.
- Tap **Original View** or **Fullscreen** to display the rollup table in the desired viewing mode.
- Tap **Group By (X)** to change the column selected for the X-axis (the Group By field) or add any column available in the report, including hidden and NOPRINT columns. On the Group By (X) submenu, the Group By column used in the existing rollup table is displayed at the top of the column names and is selected (checked) by default.
The following image shows a sample Group By (X) submenu. The column Product Type is the Group By column for the existing rollup table.

<table>
<thead>
<tr>
<th>Back</th>
<th>Group By (X)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Product Type ✓</td>
</tr>
<tr>
<td></td>
<td>Region</td>
</tr>
<tr>
<td></td>
<td>State</td>
</tr>
<tr>
<td></td>
<td>Product Name</td>
</tr>
<tr>
<td></td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Cost of Goods</td>
</tr>
</tbody>
</table>

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Rollup tab displays the modified rollup table, reflecting all the changes.

- Tap Add (Y) to change the column selected for the Y-axis or add any column available in the report, including hidden and NOPRINT columns. On the Add (Y) submenu, the Y-axis column used in the existing report is selected by default.
The following image shows a sample Add (Y) submenu. The column Cost of Goods is the Y-axis column for the existing report.

<table>
<thead>
<tr>
<th>Back</th>
<th>Add (Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Product Type</td>
<td></td>
</tr>
<tr>
<td>Product Name</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods ✓</td>
<td></td>
</tr>
</tbody>
</table>

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Rollup tab displays the modified rollup table, reflecting all the changes.

**Viewing Data in a Pivot Table**

Tap *Pivot (Cross Tab)* or touch the right arrow for the Pivot (Cross Tab) menu option to display a menu that specifies default values for the aggregation (calculation) that will be used to generate the pivot table, the column that will be displayed across the pivot table, and the Group By column that will be used to generate the table.
The following image shows a sample Pivot Tool menu. In this example, the aggregation is Sum (default for a numeric column), the Across column is Product Type, and the Group By column is Region. A pivot table requires at least one across column and one Group By column. The first value for the column in the report is displayed by default.

Tap *Done* once to see the result of the default values. The pivot table is automatically generated in tab view, and a new Pivot tab is appended after the Report tab and any other existing tabs.

The pivot table is generated in full-screen web app view by default, if you are already in that view.

On the new Pivot tab, you can change the default values to customize the pivot table for your reporting needs, making it more complex as required for analysis.
Using the Pivot Tab

The following image shows a sample Pivot tab.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Displays the active pivot menu. For details, see Using the Pivot Menu on page 76.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Freezes the pivot table. You can link or unlink a pivot table to the filters that you have applied in your report using the Freeze Pivot icon. The icon indicates whether the report is linked to the filter (Freeze Pivot) or not (Unfreeze Pivot).</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Changes the aggregation method.</td>
</tr>
</tbody>
</table>

Beneath the pivot table is the active pivot tool bar, which contains the icons described in the following table.
Using the Pivot Menu

The pivot menu and its submenus allow you to select multiple columns from those available in the report, including hidden andNOPRINT columns.

The following image shows the pivot menu.

![Pivot Menu Image]

You can:

- Tap New to create a copy of the same pivot table on a new Pivot tab.

- Tap Group By (X) to change the column selected for the X-axis (the Group By field) or add any column available in the report, including hidden and NOPRINT columns. On the Group By (X) submenu, the Group By and Across columns used in the existing pivot table are displayed at the top of the column names and are selected (checked) by default. You can switch Group By and Across columns using the arrow icons in the pivot table at run time.
The following image shows a sample Group By (X) submenu. The Product Type column is used for the Across column and the Region column is used for the Group By column in the existing pivot table.

<table>
<thead>
<tr>
<th>Back</th>
<th>Group By (X)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Product Type ✓</td>
</tr>
<tr>
<td></td>
<td>Region ✓</td>
</tr>
<tr>
<td></td>
<td>State</td>
</tr>
<tr>
<td></td>
<td>Product Name</td>
</tr>
<tr>
<td></td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>Cost of Goods</td>
</tr>
</tbody>
</table>

Tap once to select an additional column, or tap again to deselect the column. Once you select or deselect a column, the Pivot tab displays the modified pivot table, reflecting all the changes.

Tap **Add (Y)** to change the column selected for the measure field to any column available in the report, including hidden and NOPRINT columns. On the Add (Y) submenu, the measure column used in the existing report is selected by default.
The following image shows a sample Add (Y) submenu. The column Cost of Goods is the measure field for the existing report.

<table>
<thead>
<tr>
<th>Back</th>
<th>Add (Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Product Type</td>
<td></td>
</tr>
<tr>
<td>Product Name</td>
<td></td>
</tr>
<tr>
<td>Revenue</td>
<td></td>
</tr>
<tr>
<td>Cost of Goods ✓</td>
<td></td>
</tr>
</tbody>
</table>

Tap once to select a column, or tap again to deselect the column. Once you select or deselect a column, the Pivot tab displays the modified pivot table, reflecting all the changes.

**Using Data Visualization**

Tap **Visualize** to add or remove visualization bars to the selected column. The Visualize option is available for numeric data columns.

**Hiding or Restoring a Column**

Tap **Hide Column** to suppress the display of the selected column in the report.

Tap **Show All** to restore all the hidden columns to the report.

Tap **Show Columns** to list the names of the columns that are hidden in the report, allowing you to individually restore a column.

Tap the name of a specific column in the hidden columns list to restore that column to the report.

The Show All and Show Columns options are available only when there are hidden columns in the report.
Freezing or Unfreezing a Column

Tap Freeze Column to freeze the selected column and all the columns to the left of it. You cannot scroll left or right within the frozen part of the report, but you can scroll up and down within the frozen part. You can scroll in any direction in the unfrozen part of the report.

Tap Unfreeze All to unfreeze all the frozen columns in the report.

In full-screen Web app view, the column titles and report headings will stay fixed as you scroll through the report when the Freeze Column option is turned on.

Controlling the Number of Records Per Page

Tap Show Records or touch the right arrow for the Show Records menu option to list the groups of records available for display per page in the report. On the Show Records menu, you can:

- Tap a group of records (for example, 20 Records) to display, per page, only the number of records in that group.

- Tap Default to display the number of records (lines) per page that is specified in the WebFOCUS report procedure.
Running an Active Technologies Report on a Mobile Device

- Tap Show All to display all the records in a single page.

![Record Selection Table]

<table>
<thead>
<tr>
<th>Back</th>
<th>Show Records</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Default</td>
</tr>
<tr>
<td></td>
<td>5 Records</td>
</tr>
<tr>
<td></td>
<td>10 Records</td>
</tr>
<tr>
<td></td>
<td>15 Records</td>
</tr>
<tr>
<td></td>
<td>20 Records</td>
</tr>
<tr>
<td></td>
<td>25 Records</td>
</tr>
<tr>
<td></td>
<td>30 Records</td>
</tr>
<tr>
<td></td>
<td>35 Records</td>
</tr>
<tr>
<td></td>
<td>40 Records</td>
</tr>
<tr>
<td></td>
<td>50 Records</td>
</tr>
<tr>
<td></td>
<td>60 Records</td>
</tr>
<tr>
<td></td>
<td>Show All</td>
</tr>
</tbody>
</table>

Restoring a Report to Its Original State

Tap Restore Original to restore the active report to its default state specified in the WebFOCUS report procedure.

Unsupported Menu Options

The following menu options are not supported by Active Technologies for mobile web apps.

- Comments
- Send as E-mail
- Save Changes
- Grid Tool
Running an Active Technologies Dashboard on a Mobile Device

Release 8.2 Version 03 introduces Adaptive Dashboard, a feature that provides a mobile view with a fixed layout that will make dashboards easier to use while navigating on mobile devices. The first image is of the Adaptive Dashboard in a desktop environment.

Note: Active cell menu options are not supported (for example, Comments, Highlight Value, Highlight Row, Unhighlight All, and Filter Cell).
The following image is of the mobile view of the Adaptive Dashboard.

There are a number of navigational options that you can use to make it easy to get around when working with your results. These include the dashboard bar at the top of the screen that contains the page layout tabs, circles at the bottom of the screen that indicate the number of report or chart components available on the selected tab, navigation arrows at the bottom of the screen that allow you to move between components with ease, and a hamburger menu that displays available filter controls.
You can enable the Adaptive Dashboard option on new or existing In-Document Analytics documents in InfoAssist by clicking the **Adaptive Dashboard** button on the Layout tab of the ribbon, in the Page Setup group.

The following image shows a sample active dashboard that is running on an iPad, with Adaptive Dashboard disabled (this is the default).

![Sample Active Dashboard](image)

The dashboard bar at the top of an active dashboard contains the page layout tabs. On mobile devices, the bar is floating instead of fixed, making the available functions always accessible, no matter where you move within the dashboard.

You can use standard gestures on an active dashboard to scroll left and right or up and down, or zoom in and zoom out.

You can tap the **Fullscreen View** icon on the right edge of the pagination bar for an individual grid or on the right edge of a chart tool bar or pivot tool bar to view the grid, chart, rollup table, or pivot table on the dashboard in full-screen mode.
When using Adaptive Dashboard inside an iframe on a mobile device (for example, when running it from the Home Page without using the New Window option), the output is displayed with the components layout and menu options displayed when run from a desktop. If you choose to display the output in a new window, then it will display using the Adaptive Dashboard view for mobile devices.

Some of the areas impacted by this issue are:

- The WebFOCUS Home Page interactive window
- The WebFOCUS Designer
- The Collaborative Portal
- The Basic BI Portal
- The InfoMini application
- The AutoPrompt page
This topic describes how to implement design features that enhance your applications using WebFOCUS syntax.

The reports, charts, and dashboards described in this topic are enabled to use the full capabilities of Active Technologies. They are called Active Technologies reports or active reports, Active Technologies charts or active charts, and Active Technologies dashboards or active dashboards.

For more information about how to create, style, and analyze reports and charts with the WebFOCUS language, see the Creating Reports With WebFOCUS Language manual.

In this chapter:

- Controlling the Active Technologies Cache
- Suppressing the Display of the Filter Options in a Tooltip
- Styling the Filter Selection Dialog Box
- Implementing Cascading Multi Drill
- Customizing the Page Range on the Pagination Bar

Controlling the Active Technologies Cache

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the WebFOCUS Reporting Server. The server also becomes the resource for performing all calculations, sorting, and filtering when active cache is enabled. Since active cache uses on-demand paging functionality, WebFOCUS Viewer is not supported.

You can enable active cache and set its mode and format, using the SET commands described in this topic. For details on the ways that you can issue a SET command, see the Developing Reporting Applications manual.
**Syntax:** How to Enable the Active Technologies Cache for Active Technologies Reports

The syntax is

```plaintext
SET WEBVIEWER = {ON|OFF}
SET CACHELINES = {n|100}
```

where:

**ON**

Runs the active report with active cache enabled.

**OFF**

Does not enable active cache when the active report is run. OFF is the default value.

**n|100**

Specifies the number of rows retrieved from active cache. The default value is 100.

**Tip:** We recommend that you set the number of rows retrieved five times greater than the number of lines retrieved per page (as indicated in SET LINES). The minimum number of rows retrieved is 100. Setting LINES greater than 200 with the AHTML output format produces a report with no output. If editing the SET LINES syntax for a procedure with AHTML, we recommend that you code SET LINES equal to or less than 200 since the Internet Explorer JavaScript engine is slower than any other browser (such as Firefox, Opera, Google Chrome, and so on).

You can also issue the SET WEBVIEWER and SET CACHELINES commands within a request using:

```plaintext
ON TABLE SET WEBVIEWER (ON|OFF)
ON TABLE SET CACHELINES (n|100)
```

**Syntax:** How to Set the Mode of the Active Technologies Cache

The SET ARCACHEMODE command determines which HOLD files are created on the WebFOCUS Reporting Server for use with active cache. For details on HOLD files, see the *Creating Reports With WebFOCUS Language* manual.

The syntax is

```plaintext
SET ARCACHEMODE = {HOLD|NOHOLD|NOEXTRACT}
```
where:

**HOLD**
When combined with ARCACHEFMT=BINARY, this setting results in the original behavior of active cache. HOLD files for all requests are created on the WebFOCUS Reporting Server. This is the default value.

**NOHOLD**
Suppresses the creation of HOLD files for Rollup tables and charts.

**NOEXTRACT**
Suppresses the creation of all HOLD files, including the initial extract. Use this setting when the target database table is pre-built and does not change often.

You can also issue the SET ARCACHEMODE command within a request using:

```plaintext
ON TABLE SET ARCACHEMODE {HOLD|NOHOLD|NOEXTRACT}
```

**Syntax:**

How to Set the Format of the Active Technologies Cache

The SET ARCACHEFMT command determines the format in which data is stored in a HOLD file.

The syntax is

```plaintext
SET ARCACHEFMT = any_valid_database_format
```

where:

**any_valid_database_format**
Is an output file format supported by WebFOCUS, for example, BINARY or FOCUS.

- BINARY format saves report data and stores numeric fields as binary numbers. When created as a HOLD file, BINARY also generates a Master File. BINARY is the default value for HOLD files.

- FOCUS format creates a proprietary FOCUS data source. Four files result: a HOLD data file, a HOLD Master File, and two work files.

For more information on additional output file formats, see the Creating Reports With WebFOCUS Language manual.

You can also issue the ARCACHEFMT command within a request using:

```plaintext
ON TABLE SET ARCACHEFMT any_valid_database_format
```
Reference: Usage Notes for the Active Technologies Cache

The following apply when active cache is enabled:

- The Restore Original menu option is not supported for an active report that contains data visualization bars.
- The Export menu option does not export a calculation applied to a tabular active report.
- Comments for an accordion active report are cleared if you sort output with the Sort Ascending or Sort Descending command.

Suppressing the Display of the Filter Options in a Tooltip

By default, when a user clicks a riser on an active chart, two filter options are displayed in the tooltip that appears. They are Filter Chart and Exclude from Chart. Using WebFOCUS StyleSheet code, you can suppress the display of the filter options. When the user clicks a riser on the chart, the options are not available, and filtering through the tooltip is disabled.

Note:

- This feature is available for an active chart with output format AHTML.
- This feature is not available in the GUI.

Syntax: How to Suppress the Display of the Filter Options in a Tooltip

The syntax is

```
TYPE=REPORT, ALLOW-FILTER={ON|OFF},$
```

where:

**ON**

Displays the filter options in a tooltip when a user clicks a riser on the chart. This is the default value.

**OFF**

Suppresses the display of the filter options in a tooltip when a user clicks a riser on the chart. For example, the StyleSheet code is:

```
ON TABLE SET STYLE *
TYPE=REPORT,
  ALLOW-FILTER=OFF,
$ ENDDISTYLE
```
Styling the Filter Selection Dialog Box

A default set of styles for the elements of an active report is supplied with Active Technologies in a JavaScript Object Notation (JSON) file named irpcfg.json. This file resides on the WebFOCUS Reporting Server. You can overwrite the default styles and apply your own custom styles to the elements of an active report, directly, within the individual report procedure. In the procedure, you include your custom styles in a TABLE_JS block of code with cascading style sheet (CSS) class selectors, as described in this topic. The custom styles will be applied to the report elements at run time.

This feature eliminates the need for the creation and management of multiple customized files. If you have already made customizations using the files available with your software, the customizations specified in the TABLE_JS code will overwrite them.

The TABLE_JS block of code described in this topic is an extension of the WebFOCUS reporting language. It is written in the JavaScript Object Notation (JSON) data-interchange format.

The CSS class selectors described in this topic use the standard HTML CSS class attributes.

The Filter Selection dialog box is displayed on an active report at run time when the user selects Filter from a drop-down column menu on the report. This topic describes specifically how to style the Filter Selection dialog box. However, you can apply the same technique to other Active Technologies classes, such as .activeReport class.

**Note:**

- This feature is available for an active report with output format AHTML.
- This feature is not available in the GUI.

### Syntax: How to Style the Filter Selection Dialog Box

```plaintext
*TABLE_JS
  "styles": {
    "html":
    { ".arFilterButton": [ "property:value;", ... ] }
  }
*END
```

where:

**.arFilterButton**

Is an Active Technologies class that defines the overall look of the buttons on the Filter Selection dialog box. There is no equivalent option in a WebFOCUS StyleSheet to overwrite this class.
**property.value**

Is a CSS **property:value** pair that you supply to define a customized style.

**Example:** **Styling the Filter Selection Dialog Box**

The following active report procedure uses TABLE_JS code and CSS class selectors to style the Filter Selection dialog box.

The CSS properties as used in the sample procedure are described in the following table.

<table>
<thead>
<tr>
<th><strong>CSS Property</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>font-family</td>
<td>Name of a font family that is applied to an element (for example, verdana).</td>
</tr>
<tr>
<td>padding-top</td>
<td>Top padding (space) of an element (for example, 4px for a fixed top padding).</td>
</tr>
<tr>
<td>padding-bottom</td>
<td>Bottom padding (space) of an element (for example, 4px for a fixed bottom padding).</td>
</tr>
<tr>
<td>text-align</td>
<td>Horizontal alignment of text in an element (for example, center).</td>
</tr>
<tr>
<td>font-weight</td>
<td>Thinness or thickness of characters in text (for example, bold).</td>
</tr>
<tr>
<td>background</td>
<td>Different background properties in one declaration.</td>
</tr>
<tr>
<td>background-color</td>
<td>Background color of an element (for example, green).</td>
</tr>
<tr>
<td>color</td>
<td>Color of text for an element (for example, white).</td>
</tr>
</tbody>
</table>

**Note:** Colors and font styles used in the sample report procedure are intended to highlight the element that is styled and to illustrate correct syntax. They are not intended to illustrate design skill.
The active report procedure is as follows:

```
TABLE FILE CAR
"Release - &FOCREL"
SUM RCOST DCOST
BY COUNTRY
BY CAR
ON TABLE PCHOLD FORMAT AHTML
ON TABLE SET ARTABLEENGINE JSCHART
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET SQUEEZE ON
ON TABLE SET HTMLCSS ON
ON TABLE SET HTMLENCODE ON
ON TABLE SET CACHELINES 100
ON TABLE SET LOOKTABLE VBAR
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/ENWarm.sty,$

*TABLE_JS

"styles": {
"html":
{".arFilterButton":["font-family:verdana;", "padding-top:4px;", "padding-bottom:4px;", "text-align:center;", "font-weight: bold;", "background:
green;", "background-color:green;", "color:white;"]
}
}
*END
ENDSTYLE
END
```

At run time, the preceding code generates the following output. The TABLE_JS code is applied to the elements that are not styled in the WebFOCUS StyleSheet. For example, a green background with white text is applied to buttons on the Filter Selection dialog box, as shown in the following image.
Implementing Cascading Multi Drill

The cascading multi-drill feature enables you to:

- Create multiple drill-down links on a data field in an active report. For example, you can create a link to a JavaScript function, a URL, or a detailed report with data that supplements the first report and extends your scope of analysis.

- Arrange the drill-down options for a link in cascading fashion on the active report at run time.

- Apply global styling to all the cascading multi-drill menus within the current active report, or item-level styling to a single entry on a menu.

The cascading multi-drill feature supports multiple menu items, as well as multiple cascading levels. It is implemented in the WebFOCUS language. It includes WebFOCUS StyleSheet code for the customized display of menus and menu items. Cascading multi drill can be incorporated in any active report that works with JavaScript (for example, HTML or DHTML).

**Note:** Currently, you cannot implement cascading multi drill in the GUI.
You will see a hyperlink on an active report when a data value on the report has drill down or multi drill. By default, the hyperlink is displayed in blue and is underlined. The following image shows an active report with cascading multi drill. A cascading menu is accessed at the cell level of an active report. In this example, the end user left-clicked the linked data field named Coffee.
As shown in the next image, you can apply custom styling to the drill-down menus and menu items on the active report, using WebFOCUS StyleSheet code.

For details on the syntax for linking to other resources and for styling cascading multi-drill menus, see the Multi-Drill Feature With Cascading Menus and User-Defined Styling topic in the Linking a Report to Other Resources chapter in the Creating Reports With WebFOCUS Language manual.

Customizing the Page Range on the Pagination Bar

The default string and parameters used to display the page range on the pagination bar of an active report are stored on the WebFOCUS Reporting Server in a file supplied with your software. Instead of using the default values stored on the server, you can specify your own customization values within an individual active report procedure, using the TABLE_JS syntax described in this topic. The values specified in the TABLE_JS code will overwrite the default values, and the customized page range on the pagination bar will be displayed in the active report output.
This feature eliminates the need for the creation and management of multiple customized files used in many applications. If you have already made page range customizations using the files available with your software, the customizations specified in the TABLE_JS code will overwrite them.

**Note:**

- This feature is available for an active report with output format AHTML.
- This feature is not available in the GUI.

**Syntax:**

**How to Customize the Page Range on the Pagination Bar**

The syntax is

```plaintext
*TABLE_JS
 "strings":
 { "paglinetext":"customized_string" }
*END
```

where:

*customized_string*

Are the parameters that you supply to customize the page range on the pagination bar. Valid values are described in the following table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%inds</td>
<td>Displays the current page number and allows you to type over it with the number of a page to go to.</td>
</tr>
<tr>
<td>%ind</td>
<td>Displays the current page number. Does not allow you to type a go-to page number.</td>
</tr>
<tr>
<td>%frcs</td>
<td>Is the number of the first record that is displayed. It is a cumulative number from the first record on the first page, up to the first record on the current page.</td>
</tr>
<tr>
<td>%lrcs</td>
<td>Is the number of the last record that is displayed. It is a cumulative number from the first record on the first page, up to the last record on the current page.</td>
</tr>
<tr>
<td>%trcs</td>
<td>Is the total number of records.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>%pers</td>
<td>Is the percentage of the total records that are displayed when a filter is applied.</td>
</tr>
<tr>
<td>%pgs</td>
<td>Is the total number of pages.</td>
</tr>
<tr>
<td>%rcs</td>
<td>Is the total number of records when a filter is applied.</td>
</tr>
<tr>
<td>%tn</td>
<td>Is a table number used only for internal purposes.</td>
</tr>
</tbody>
</table>

**Example:** Customizing the Page Range on the Pagination Bar

The following active report procedure uses TABLE_JS code to overwrite the default page range on the pagination bar.

In this example, the number of records displayed on each report page is set in the report procedure by the WebFOCUS StyleSheet attribute LINES-PER-PAGE. You can also set the number of records (lines) per page in the GUI for InfoAssist and App Studio. For more information on the GUI procedure, see the manual for the graphical tool that you are using.

The LINES-PER-PAGE and TABLE_JS code are shown in bold in the example.

**Note:** If you want to run the example in this procedure, you must combine the two lines of code between the braces in the TABLE_JS block, so that they are a single line of code, as required by the syntax rules.
TABLE FILE CAR
PRINT
   CAR.BODY.DEALER_COST
   CAR.BODY.RETAIL_COST
   CAR.BODY.SALES
BY  LOWEST CAR.ORIGIN.COUNTRY
BY  LOWEST CAR.COMP.CAR
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE NOTOTAL
ON TABLE FCHOLD FORMAT AHTML
ON TABLE SET HTMLCSS ON
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/ibi_themes/Warm.sty,$
$ TYPE=REPORT,
   LINES-PER-PAGE=10,
   AGRAPHENGINE=JSCHART,
   ALLOW-TOOLS=OFF,
$
*TABLE_JS
   "strings":
   { "paglinetext":"%frcs - %lrcs out of %trcs records, Page %inds of
   %pgs<span id='smsg%tn'></span>" }
*END
ENDSTYLE
END

At run time, the preceding code generates the following pagination bar on the active report. The underscore in Page 1 indicates that you can type a go-to page number here.

1 - 10 out of 18 records, Page 1 of 2 ►►►

To remove the capability to type a go-to page number, use the %ind parameter instead of the %inds parameter in the TABLE_JS block, as shown here.

*TABLE_JS
   "strings":
   { "paglinetext":"%frcs - %lrcs out of %trcs records, Page %ind of %pgs<span
   id='smsg%tn'></span>" }
*END

The active report will display the following pagination bar, with no underscore in Page 1.

1 - 10 out of 18 records, Page 1 of 2 ►►►
Index

A

active cache 17
active dashboards 41
active report Options dialog box 28
  Advanced tab 32
  Colors tab 31
  General tab 29
  Menu Options tab 30
Active Technologies
  for charts 36
Adaptive Dashboard 81
adding report or dashboard to Home screen 56

C

charts
  using Active Technologies 36
  types for mobile web apps 61

D

documents
  cascading prompts 49
documents
  changing the filter condition 48
  setting target reports 41

G

gesture support 52

H

horizontal menu 14

I

interactive reports 14
  horizontal menu 14
  vertical menu 14

R

running report on mobile device 55

V

vertical menu 14
Feedback

Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor, Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.